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Introduction

The aim of this chapter is to introduce the SunSystems PSA application
to you.

What you will learn
When you have completed this chapter you will be able to:

*Describe how your office will use the SunSystems PSA application.

*Understand how to use this guide.

What you know already

Before you start this chapter you will need prior knowledge and practical experience
in:

*How you see SunSystems PSA used in your office to complete your work activities.

What you will need
To complete this chapter you will need:

*This Chapter.

SharpOWL software is protected by international copyright laws. SharpOWL and the SharpOWL logo are
international trademarks.
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Techie Talk

Click: To press and release the left mouse button without moving the mouse. See
also Right Click and Double Click.

Double Click: To press and release the left mouse button twice quickly without
moving the mouse. See also Right Click and Click.

Expand: To display more information from a data tree.

Professional Services Automation (PSA): The automatic control, creation and
reporting of time and expense entry, budgets and billing.

Portable Document Format (PDF): A generated file that is read using Adobe
Acrobat Reader.

Right Click: To press and release the right mouse button without moving the mouse.
See also Click and Double Click.
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Section 1

Introduction

What is PSA?

‘...the Professional Services Automation (PSA) solution that supports and enhances
your business process, allowing you to IDENTIFY, MANAGE and RETAIN the right
clients, the right people and the right information.’

Using the SunSystems PSA application, the user will be able to:

1. Identify, service and retain the right clients

eldentify and target profitable customers

*Track your client relationships from bid to cash collection

*Provide your clients with accurate and timely information and work in progress
reporting and publishing.

2. Identify, manage and retain the right people

*Pinpoint the staff you need to resource you projects
*Match the right resources to the right tasks

*Service your clients with the right people for the job.
3. Identify, share and retain the correct knowledge

*Collect valuable information from multiple sources
*Automate distribution of vital information

*Access business critical information to improve strategic decision making.
4. ldentify, manage and retain your areas of profit and cost

Efficiently schedule and maximise your use of resources
*Collect your billable hours and expenses information more accurately and timely
*Drive recovery by providing detailed and accurate billing information

*Reduce administration through quicker and easier collection of information.
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PSA and the Services Lifecycle
By gathering business critical information at source, SunSystems PSA provides
managers with the knowledge to increase business performance and client satisfaction
through efficient utilisation of resources and skills. SunSystems PSA helps the
information to flow through your organisation to the right people.

SunSystems PSA gives you complete vision of all of your projects, and allows you to
share information with your clients, securely and easily.

The diagram below shows the services lifecycle and how SunSystems PSA improves
the business process.

Your Clients
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Find and Retain Business

eImprove contact and communication with customers and prospects
*Evaluate and manage opportunities more effectively

«Streamline and rationalise your bid process

*Better co-ordinate your sales and marketing opportunities.

Plan Your Project

*Define your projects by tasks and activities

*Schedule your available resources, matching skills with availability
*Accurately set budgets, define costs and billing rates

*Establish approval processes

*Schedule your billing

«Communicate your plans and resource schedules to all relevant parties.

Service and Manage Your Projects

*Capture time information quickly and accurately
*Process and approve expenses quickly
«Capture knowledge from across the organisation
*Manage projects more effectively.

Monitor Project Progress

*Track and publish status reports
*Alert client of key milestone achievements/delays
*Approve/deny/comment on information captured.

Charge and recover

*Manage complex billing scenarios

*Recharge to other cost centres

Full visibility of costs, income and margin

*Quick and easy approval and cash collection
eAutomatic feed into ledgers and accounting systems.

Measure Project Results

*Performance evaluation of resources, utilisation, project profitability etc.
*Visualise your business through intelligent reporting
eSearch for, request and share knowledge

*Make informed strategic business decisions.
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Section 2
Using The User Guide

Introduction

The User Guide is presented for your use as an on-line Adobe PDF (Portable
Document Format), which you can use on-line or print the required sections as and
when you need them.

This section will explain the layout of the User Guide and give instructions for using the
Adobe Acrobat Reader.

Please Note

If you use a Hypertext link to another part of the document and wish to return to the
page that you were looking at, use the ‘View History’ buttons.

Right clicking on the User Guide will open a pop up menu with some of the more
frequently used commands available.

When printing the guide, remember to specify the Acrobat page numbers found at the
bottom of the screen.

e | M A 2ofdr K M B26x11 6900 |I:I = HA =
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User Guide Layout

The User Guide can be provided to you as one document containing all of the guide or
as several documents one for each chapter of the guide.

Each Chapter has (in this order):
Title Page : Showing the Title of the Chapter

Table Of Contents: Lists the Sections in the Chapter and their section numbers
including Hypertext links to the Sections

Document Reference Page: Shows the Chapter project information

Document Amendment History: Shows the amendments made to the Sections
within the Chapter

Chapter Introduction Page: Tells you what the Chapter covers, what you will learn,
what you know already and what you will need

Techie Talk: An explanation of technical terms used in this Chapter

Sections: The information relevant to this Chapter

Index: Index of Sections and Sub-Sections including Hypertext links to them

As well as the Chapter pages, the User Guide also includes the Table of Contents for

the whole guide (including Hypertext links) and a Preface which explains copyright
information, and conventions used in this guide

Book Contents |Chapter Contents | Chapter Index 4 1-2-2
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Using Adobe Acrobat Reader
Please Note

You can access the Adobe Acrobat Reader Guide at any time from the Help menu or
by pressing .

In these instructions, the guide will refer to the toolbar buttons, however, the same
functions are available from the appropriate menus

1. Open the User Guide
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Changing The View
To Change the View:

1. Click the |[§ I button to view the guide in actual size

2. Click the I button to fit the whole page in the window

3. Click the |i"| button to fit the full width of the page in the window

4. Click to rotate the page through 90 degrees anti-clockwise

5. Click to rotate the page through 90 degrees clockwise

6. To view the page Full Screen, select Full Screen from the View menu
'@ File Edit Document | Yiew Window Help

Full Screen Chrl+HL
Zoom In Chel++
Zoom Cuk kel
Zoom Ta... CEElH
Fit: in windo kel
Actual Size Zhrl+1
Fit Width Chrl+2

v Fit Visible Chrl+3
Reflo Zhel -4

v Single Page
Conkinuous
Continuous - Facing
Rotate Clockwise Ckel+Shift++
Rotate Counterclockwise  Crrl+3hift+-

7. To return to normal view, press the ' ESD| key

8. Select the options from the View menu as required to view a single page at a time,
as a continuous document or as double sided facing pages

v Single Page
Cankinuous

_onkinuous - Facing
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Navigating
To move around the User Guide:

1. Click the |4 | buttons to move to the next or previous page as required

2. Click the | |4 ||| buttons to move to the end or beginning of the document as

required

3. Click the | 4@ = | buttons to move backward and forward through the view

‘history’ as required

4. The current page number will be displayed in the small window at the bottom of the

screen] 2of 47 |, to move to a known page number, highlight the numbers in the
window and enter the required page number

Please Note

It is not necessary to enter the ‘of xxx’ part of the page numbers. It is only necessary to
enter the page number.

To use the Bookmarks:
Where a bookmark has the symbol []. you can click on the [[5] to expand the tree view

1. Click on the required page bookmark to go to that page

To Use Thumbnails:

1. Click the tab

Thumbnails

2. Click the required page to go to that page
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To Use Contents Pages:

1. Open the required Contents page

2. Click on the required Section Title or Number to go to the first page of that section
To Use Index Pages:

1. Open the required Index Page

2. Click on the required index entry

3. The page that contains that index entry will open

To use the Find Function:

1. Click

2. Enter the word that you want to find
3. Check the Match Whole Word Only box to give only exact matches
4. Check the Match Case box to make the search case sensitive

5. Check the Find Backwards box to start the search and the current position and
search backwards

6. Click I Find I to continue

Please Note

Acrobat Reader will find the next match of your search criteria and go to the page where
the match occurs.

7. If you want to look for the next place where your word appears, click and

cIickI Find Again I
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To Use The Hypertext Links:

1. Where you find a word or phrase within the User Guide highlighted in red, this is a

hypertext link. When you pass the cursor over the link, it will become a qﬁ,

pointer

2. Click on the link, the window will display the linked page

3. To return to the previous page, click the left history arrow | 4@ &
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Printing The User Guide

To Print the User Guide:

1. Open the Print Setup window (File = Page Setup)

Print Setup

— Printer

2%

M ame;

Statuz:
Type:
Wwhere:

Ready
HF Lazer)et 4050 Sernes PCL Se

Development - Technical Authors Area
Comment; Technical Authors

— Paper Orientation
Size: I.-i'-.d j " Parlrait
Source; I,-’.'-.utu Select j ™ Landscape

etworlk... | ] I Cancel

2. Change the printer and settings as required

3. Click Properties. ..

[

to change or view the printer properties

4. Click to continue
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5. Either click the button, or select Print from the File menu

(x|
— Printer
K Properties |
Statuz - Feady [~ Reverse pages
Type: HF Lazerlet 4050 Sernes PCL Se [ Print az image
YWhere:  Development - Technical Authors Area [ Frint ta file
— Print Range — Copies and Adjustments
Lol | € Selected pages/graphic Mumber of copies; 1 =
™ Cumrent page
" Pages from: I'I bo: |4? W Shiink oversized pages to paper size
= :
Brint IEven and 0dd Pages j ¥ E=pand small pages to paper size
[T Auto-rotate and center pages
v Comments

= Fostscript O phions Preview f—8.26—4

Frint Method: - ¥l anguage Level 2 j
¥ Optimize for Speed
¥ Download &sian Fonte 21 Save Frinter b emony

Color Managed:  On printer

nits: Inches Zoom: 39.9%

Frinting Tips | Advanced... I k. I Cancel

6. The printer and settings can also be changed from here
7. Select which pages to print and the number of pages to print

Please Note

When printing the guide, remember to specify the Acrobat page numbers found at the
bottom of the screen.

e | M A 2ofdr K M B26x11 6900 |I:I = HA =

8. Click I oK I to print
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